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Don't let sloppy hyphenation and ,
justification ruin your pages!
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hen the topic of hyphen-
ation and justification
comes up in my design
classes, students’ eyes
glaze over. “H&J," an old
industry term, sounds
like one of those esoteric
things you can surely do
without. After all, has anyone ever told you, “Your
H&J needs are-do!"? Yet there you are, perusing a
page of justified text that has big gaps between
words (especially where there are text wraps),
and instead of reading across, your eyes inevi-
tably drift downward, following the cascading
sequence of gaps. Oh my. You're experiencing
the dreaded phenomenon known as “rivers of
white space”” Then you glance across the page
and your eyes flit between several dark patches
where words are uncomfortably crunched to-
gether. More problems.

Maybe you set your body copy with flush-left
alignment and these problems don't plague you.
Yet the nagging feeling persists that your three
columns of text are not up to par. You notice
numerous short lines sprinkled throughout with
as few as four words per line, and gutters that
look twice what they're spec’ed. Will readers get
discouraged, struggling to read?
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Even Typographic Color

These examples of poor readability are the clas-
sic symptoms of H&J neglect. We hyphenate,
whether text is flush left or justified, to achieve
what’s known as even typographic color. When you
squint your eyes as you look across the page or
spread, you should see an even and consistent
grayness in the body copy. If type is justified, the
composition engine may expand or contract word
spaces, letter spaces, and perhaps even horizon-
tally scale each character to achieve flush edges.
The effective color gets lighter when spaces are
expanded, and darker when jammed together.
With these uneven patches, the page takes on
a blotchy look.

Turning on hyphenation and setting appro-
priate controls lets you even out the color by
breaking up words at the line ends, either reduc-
ing or opening the space between words and
letters as needed.

With flush-left text, the word and letter spacing
is typically controlled by the font designer, and
assuming you're using type from a good-quality
foundry, consistent spacing is built into the font.
But there can still be uneven typographic color
at the line ends. Lines with only four words may
be sandwiched between lines that extend the full
width of the column or frame. Without proper
hyphenation, this kind of range between the
shortest and longest lines creates an unevenness

What is H&J?

Long before computers became desktop
machines, Hyphenation and Justification (H&J)
have been paired as closely as peanut butter
and jelly. And for good reason. When type is fully
justified with word- and letterspacing, text can
look horrid unless some lines are hyphenated.
Without those small hyphens to help even out
the spacing, individual syllables to be exact, the
difficult job of justifying falls heavily on those
word spaces. Since newspapers and books have
pretty much always had justified text, not to
mention illuminated manuscripts, it's long been
well known that it takes two to tango—H and J
together or readership suffers.




Figure 2: The first step in
getting good hyphenation
is turning it on. Here are
two sets of text before and
after hyphenating—on
the left, justified text,

and to the right, flush-

left text. Note the
Hyphenate checkbox on
the Control palette, which
indicates whether these
selected paragraphs are
hyphenated.
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in the color at the line ends. By introducing more
hyphenation, the range can be narrowed, result-
ing in a more even flow.

Either way—flush left or justified—achieving
an overall consistent spacing in your body copy
is one of the most important principals of typog-
raphy. The goal is to communicate your message
so that readers can absorb it without the distrac-
tion of uneven light and dark patterns. If your
type is not well-set and doesn't invite the reader
in, you're likely to lose your audience. Although
hyphenation is not a one-size-fits-all solution, it's
also not rocket science. With a little effort, you can
easily fix these problems, adding immeasurably
to the positive experience your readers will have
as they absorb your message.

The Big Four
Now that you understand why you need hyphen-
ation, there are four questions to answer on the

g =0 '_“u,.,..r... 0] | |mem 14§ =0

road to good hyphenation: how, which, when,
and where. How do you turn on hyphenation?
Which method will you use to apply hyphenation?
When is a hyphen needed? And once there’s a
need, where will a hyphen be inserted?

Here's a hint—all the answers are pretty
straightforward except “the when,” or the fre-
quency of hyphenation. Your choices in the
Hyphenation and Justification dialogs (Window >
Control > Paragraph view) (Figure 1) have a big impact
on all of these outcomes.

The How: Turn on Hyphenation
After placing text, click inside it with the Type tool
and go to Edit > Select All (Cmd-A/Ctrl-A) to highlight
all the text of the story. Go to the Control palette,
paragraph view, and click the Hyphenation check
box. What a difference! InDesign instantly trans-
forms paragraphs (Figure 2).

Note that while the checkbox is on by default,
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Figure 1: Only in
illustrations can you select
both at the same time!
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hyphenation may not be automatically applied to
placed text. Kind of confusing? The default hyphen-
ation applies automatically when you type text
into a new frame. But when you place text, then
click in the story or highlight text, the Hyphenate
checkbox most likely is not on! Be aware.

The Which: Adobe Paragraph Composer
InDesign has two hyphenation methods, and the
Adobe Paragraph Composer is the default. Leave
it that way! The Paragraph Composer is one of the
most important typesetting innovations Adobe
has introduced in page-layout software, bringing
the quality of desktop type much closer to what
a dedicated typesetting machine could do. In
traditional typesetting, the hyphenation engine
would assess the needs of an entire paragraph
at one time, choosing the most strategic lines
to hyphenate for best overall results. With the
introduction of the Paragraph Composer, you
have that same advantage.

Your other choice is the Adobe Single-Line
Composer. It examines one line at a time, starting
from the first to the last line of a paragraph, and,
in each case, decides whether or not to hyphen-
ate based on the policies and parameters set.
Because it doesn’t deal with the paragraph as a
whole, you can get some pretty bad line breaks
toward the end of a paragraph.

The only time I switch to the Adobe Single-Line
Composer is when | want to hand-rag my type;
that is, manually control the in-and-out profile of
the line endings. (See the sidebar“Hand-Ragging
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Type!") If your type is flush left, very visible, and
not lengthy (advertising copy is a good example),
it's not unusual to manually control every line
break. When the Paragraph Composer is on and
you're trying to manually control the rag, changes
you make on one line may not only affect the
composition on that line and subsequent lines
in the paragraph, but can also affect line breaks
above your change! By changing to the Single-
Line Composer, you can avoid these problems.
Consider creating a paragraph style for body copy
which turns on the Single-Line Composer, just
for this situation.

The When: Frequency of Hyphenation
When do you increase or decrease hyphenation?
The most challenging of the four steps of hyphen-
ation—how, what, when and where—is clearly
the when, controlling the frequency. While you're
likely to stick with one hyphenation method (the
Paragraph Composer) and keep your policy set-
tings stable (see“The Where” below), setting how
often hyphenation is needed is a moving target.
That's because the most significant factor when
hyphenating is the column width, whichisin turn
affected by the page size, side margins, and gut-
ters. If you're not using columns to structure your
layout, substitute “frame width”for “column width”
and the principles are just as relevant.

As an example, look at two common page
grids: two- and three-column setups for a stan-
dard US Letter, portrait orientation (Figure 3).
When type is justified to the wider width of the

Hand-Ragging Type

Sometimes, you can improve the look of your
type by manually creating new line breaks

in a paragraph. For words that are not in the
dictionary, you can insert a discretionary
hyphen within a word to allow it to hyphenate.
With an insertion point in the word, go to Type >
Insert Special Character > Discretionary Hyphen (or type
Command/Ctrl-Shift-hyphen). Or you might
want to force a word or two down to the next
line by removing the hyphen (forcing InDesign
not to hyphenate the word). In that case, insert
a discretionary hyphen immediately before the
word, or select the word and choose No Break
from the Control palette or Character palette
flyout menu.

Many people use a soft return (Shift-Return or
Shift-Enter) or even a hard return (without the
Shift) but those methods can lead to mistakes.
When the text gets edited on a previous line
in the paragraph, that return character will still
create a line break, but it might fall at the begin-
ning of a line. The discretionary hyphen is smart.
When editing makes the hyphen unnecessary, it
just disappears.
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two-column setup, the default word and letter
spacing typically isn't bad, even with hyphen-
ation off. The type engine has lots of words and
word spaces to work with while justifying. Simply
turning on hyphenation might be all you need.
But the same justified text, placed in three col-
umns, cries for more, even with hyphenation on.
With fewer words on a line, there’s less flexibility
in spacing, yet the type engine still must justify.
Rivers of white space are sure to show up, and
readability drops.

When type is set flush-left, the column width
is important for different reasons, having to do
with the rag. If you were to connect the dots
from one line ending to the next, what would
the rag look like? Without hyphenation, all lines
break only at word endings. That gives you big
swings between the shortest and longest lines,
sometimes referred to as a “loose” or “hard” rag.

Quark user panics over no
"H&J" settings

With hyphenated text, however, it's a more subtle
look. This sawtooth rag is said to become “tighter”
or“softer,” with a more uniform line length.
When you left-justify a two-column layout, a
loose rag with little to no hyphenation may be
just fine because there’s a long line length to
balance all the variance. The more generous rag
may even offer a benefit of opening up that wide
text block, making it more approachable. But
when text is in three columns without hyphens,
that loose rag may mean poor readability, with
an insufficient number of words per line. There's
a common rule of thumb—around 40 characters
or 8 words per line is optimum, regardless of
your line length. When you increase hyphenation
for flush-left text set to a shorter measure, you'll
get a tighter rag, and more words per line. With
a longer measure, more fluctuation is fine. In
either case, flush-left or justified, you'll want to

Figure 3: The line length

is key to how much
hyphenation is needed.
Comparing here a two- and
three-column setup, no
hyphenation for either, the
justified text set to a longer
measure on the left is much
more evenly spaced by
default. With the narrower
width, on the right, uneven
gaps occur more frequently
and require more attention.

Hyphenation Cheat Sheet

Alignment 2-column (wider 3-column (narrower
measure) measure)
Flush-left Minimal hyphenation Increase hyphenation.
needed. Looser rag. Tighter rag, better
word fit.
Justified Minimal hyphenation Increase hyphenation.

needed. Typographic color | Better typographic
is more even by default. color.
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increase hyphenation when the column width
is narrower.

For a visual of these differences, see Figure 4.
The“Hyphenation Cheat Sheet”table on the pre-
vious page sums up best practices.

Now that you understand what's needed, let’s
look at InDesign’s tools to do it!

InDesign’s Frequency Controls. Controlling
the frequency of hyphenation should normally
be the domain of the designer or possibly the
production artist—typically not the editor. This
is where your expertise comes into play to ensure
that you maintain good readability. You'll prob-
ably need both the Hyphenation and Justification
dialogs to control how often text is hyphenated.
For flush left type, the Hyphenation dialog is all
you'll need. However, for justified, the frequency
of hyphenation is directly affected by controls in

Quark user panics overno
"H8J" settings
Trouble Spot: I'm a newl

Not getting enough
hyphenation for flush left

the Justification dialog as well. Reminder, you can
find the Hyphenation and Justification commands
in the Control palette menu, paragraph view.

Before you select either command, change
your view to Fit Page in Window or Fit Spread
in Window (Cmd-0 or Cmd-Option-0; or Ctrl-0
or Ctrl-Alt-0) to see the effects of your settings
across a broader area.

Start with the Hyphenation dialog after se-
lecting some flush-left text. If you missed the
checkbox on the Control palette to turn on
hyphenation, the Hyphenate checkbox in this
dialog box offers another opportunity. Below the
checkbox are numerous settings that may at first
appear to affect frequency, but in fact, they are
policies that control where hyphens are inserted.
I'll come back to them shortly.

First, turn on the Preview checkbox so you can
immediately see how your new settings play out

Figure 4: Again, you can
see the same two and
three columns of text,

but now it’s set flush-left,
hyphenation still off. Here
the rag in the two-column
text is very loose, with big
swings from shortest to
longest lines. With a long
line length, the looser rag
is fine. But the same text
set in three columns, with
no hyphenation, looks
pretty bad—the series of
many short lines creates an
unattractive profile.

Figure 5: The “mystery meat” slider bar is actually
straightforward for flush-left text. Think of “Better Spacing”
as simply meaning “More Hyphens.” When it comes to
justified text, however, “Better Spacing” takes a serious nod
from the settings in the Justification dialog.

Hyphenation Settings

Wit —o—)
Words with at Least: 5 letters ————
r — [ Cancel
After First: 2 letters 5 o
o P
Before Last: 2 letters LI
Hyphen Limit: 3 hyphens

Hyphanation Zona: 3p0
Barur Spacing Fawar Wyphera

™ Hyphenate Capitali

rds “ Last Word




Tip: Tighten Up!
The Justification
dialog box'’s Desired
setting affects flush-
left text for all three
functions. If you
have a funky font
where the body
copy letter spacing
is loose, the Desired
field is an excellent
place to tighten
itup.
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on the page. Take a look at what | call the“mystery
meat” slider bar: Better Spacing—Fewer Hyphens,
with eleven notches to choose from (Figure 5).
When you drag the slider to the right, toward
Fewer Hyphens, your flush-left type will have a
looser, more ragged-right edge. When you drag
it to Better Spacing, you get more hyphens and
a tighter, more controlled rag. For flush-left type,
think of the slider’s endpoints as“More Hyphens—
Fewer Hyphens!” Easy enough, no mystery yet!

Click OK.Then select some paragraphs of justi-
fied text and return to the Hyphenation dialog.
Drag the slider toward Better Spacing. You'll see
a change, but what exactly is happening to your
text? Here's the mystery. While Better Spacing can
certainly mean adding hyphens, it can also affect
much more—including word and letter spacing,
as well as something called Glyph Scaling. To un-
derstand how these other attributes figure into
the mix, you'll have to close the Hyphenation dia-
log box and choose Justification from the Control
palette or Paragraph palette menu.

In the upper half of the Justification dialog
box is a grid for controlling Word and Letter
Spacing, as well as Glyph Scaling in justified text.
For each function, there is a possible range from
a Minimum to Maximum setting, and a Desired
setting with a value that must fall between the
two outside values (Figure 6). The secret about
this array is that the settings in the Justification
dialog are the levers to control frequency of
hyphenation for justified text. Yet there’s nothing
in the dialog to suggest that relationship!

Justification

Minimum Desired Maximum

Word Spacing: 80% 100% 133%

Letter Spacing: 0% 0% 0%

Clyph Scaling: 100% 100% 100%

Auto Leading: 120%

Single Word Justification: = Full Justify B:

Fa

Cancel )

%Preview

Composer:  Adobe Paragraph Composer I—:J

Take a closer look.

As you've seen, InDesign typically expands
word spaces in some places and reduces it in oth-
ers when justifying lines. The program’s defaults
in this grid give the composition engine permis-
sion to compress a word space to 80% of a normal
space and enlarge it by one-third, 133%, to justify.
When the engine follows these guidelines but
still can't justify, it tries to kick in Letter Spacing.
However, that’s a no-go by default, with 0% for
all three Letter Spacing settings. InDesign could
try to throw in some Glyph Scaling to justify. The
letterforms themselves can be scaled horizon-
tally, ranging from a condensed letterform, under
100% for Minimum, to an expanded letterform,
over 100% for Maximum. But with all settings the
same, 100%, Glyph Scaling is also not allowed
by default.

So what is the poor type engine to do? It still
needs to justify, so it resorts to hyphenation.
The hyphenation engine is like a high-flying fat
cat who doesn’t want to work and won’t, un-
less forced. If the engine can justify without
resorting to hyphenating, it will. Translation: If
your ranges in this grid are generous enough,

Figure 6: The Justification
dialog may look a bit
daunting, butit’s a
powerful tool to increase
or decrease hyphenation
for justified text. Narrowing
the ranges from Minimum
to Maximum increases the
hyphenation frequency.



Word Spacing

Letter Spacing:
Glyph 5caling:
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Single Word Justification:
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Justification Justification

Minimum Desired Maximum i ) Desired M, ( oK , Desired M ( oK ’
RO 100% 133% Word Spacing: BO% 100% 133% d Word Spacing: 80% 100% 133%
% 0% 0% = Cancel—) Letter Spacing: 0% | 0% T20% _Cancel Letter Spacing: 0% | 0% 20% Cancel
100% 1006 | 100% #;kPrevlew Clyph Scaling: 1008 | 100% ok & Preview Glyph Scaling: 'ga:g Thoo% [100% & Preview
120% Auto Leading: 120% Auto Leading: 120%

Full Justify ) Single Word Justifi Full Justify ] Single Word Justifi Full Justify ]
| Adobe Paragraph Compaser E! Composer:  Adobe Paragraph Composer I@ Composer: | Adobe Paragraph Composer I@

InDesign may justify the text without a single
hyphen and instead, manipulate word spacing,
letter spacing, and glyph scaling to get the job
done. Hyphenation is almost the last resort.

There is one thing more that InDesign will
do if hyphenating doesn’t get the job done. It
expands and/or contracts word spacing beyond
your ranges. Ditto for letter spacing and glyph
scaling if you allow for any variance in those
ranges. The specific algorithms that Adobe
uses to manage all this is dazzling, I'm sure. But
this is as far into the mystery as you and | can
easily go.

Setting Recommendations. Making justified text
look great can be a challenge. Just remember that
when you have a wider column or frame width,
chances are you'll be able to even out your letter
and word spacing by dragging the Hyphenation
slider bar a notch or two toward Better Spacing.

If your justified text is set to a shorter measure
and you see more exaggerated unevenness with
light and dark patches, start by dragging the
Hyphenation slider farther to the left, toward
Better Spacing. But if you're still getting gaps
and want to kick in more hyphens, switch to
the Justification dialog and decrease the Word
Spacing ranges by raising the Minimum value
and decreasing the Maximum value.

| believe you can achieve a more even typo-
graphic color by allowing some amount of letter
spacing to occur. The ideal letter spacing varies
by person, of course. | may set my Maximum as
high as 15 to 20%. Other designers are much
more conservative. Conversely, | don't like to
use letterspacing’s negative minimum value to
tighten body copy. Others see no problem with
a small negative percentage.

With Glyph Scaling, you're changing the pro-
portions of the letterforms. That's controversial.

Figure 7: Word spacing for
justified text can get really
bad when line lengths

are shortened, especially
common with text
wrapping. Look at the text
just opposite the graphic
on the far left. Notice the
large word space gaps that
occur when the default
settings are unchanged

in the Justification dialog.
In the second and third
examples here, the gaps
are evened out by adding
first letter spacing (20%
Maximum) then Glyph
Scaling (95% Minimum).



Figure 8: The good news
about the policies in the
upper portion of the
Hyphenation dialog is that
you usually don’t have

to alter them very often.

If you customize your
settings when you have no
files open, those numbers
will be in effect for all new
InDesign files.

While type purists shun this feature, other people
find it helpful in very small doses—that s, arange
from 98% and 10 2%. (Figure 7).

The Where: Rules or policies

Once the Composer and your frequency settings
have determined that hyphenation is needed
for a paragraph or a line of text, someone must
decide where hyphens should be inserted. This is
one area where editorial policy may govern and
the designer simply implements. Begin by going
to the Hyphenation dialog to set the policies or
rules (Figure 8).

Below the Hyphenate checkbox are several
text entry fields where you can control where
textis hyphenated in both flush-left and justified
text. Remember to turn on the Preview checkbox
so you can see the immediate effects of your
choices.

Here's a breakdown of Hyphenation policy set-
tings and defaults and my recommendations:

Hyphenation Settings

— M Hyphenate E
Words with at Least: 5 | letters
After First: 2 | letters ;
Before Last: 2 | letters %Prewew
Hyphen Limit: 3 | hyphens
Hyphenation Zone: 3p0
Better Spacing ] Fawer Hyphens
™ Hyphenate Capitalized Words M Hyphenate Last Word

} Words with at Least: 5 letters—A word with 5
letters can be hyphenated between two syl-
lables, one with two letters, the other three,
such as “re-ply or “com-ic” The question is,
are you willing to accept a minimum of two
or three letters at the end of a line before a
hyphen? A more conservative choice here is
6 letters minimum.

} After first: 2 letters—If you stick with the de-
fault five-letter word, you can still have three
letters before the hyphen, but then the fol-
lowing line will start with only two letters.

} Before last: 2 letters—If you choose a mini-
mum of 6 letters in a word, then you can have
3 letters before and after the line break. Nice
way to go.

} Hyphen limit: 0 hyphens—How many consecu-
tive lines of hyphenated text do you want to
allow? Most often, the answer is two. When
you leave the default of zero, you're letting
InDesign have an unlimited number of lines
end in hyphens. To avoid this, entera 1 or 2.

} Hyphenation Zone—By default the Hyphen
Zone s no longer relevant, though historically
it has been the key to hyphenating flush-left
text.I'd setitat Op or 0"

} Hyphenate Capitalized Words and Hyphenate
Last Word—Many editors have strong feelings
about these last two policy options. With the
former option checked by default, your com-
pany name and the names of products and
services will be hyphenated. With the latter,
sticking with the default option on means

Control the Hyphenation Dictionary

In a multisyllabic word, you sometimes want to
know between which two syllables InDesign’s
dictionary prefers to hyphenate, and what
other possible breakpoints the dictionary will
consider.

To see these possible hyphenation points, go
to Edit > Spelling > Dictionary. When you choose Dic-
tionary..., a dialog box opens that lets you enter
the word for which you'd like to check spelling
or hyphenation points. If you select a word in
your document before choosing the command,
the word is automatically entered in the field.

When the word is in the field, click the
Hyphenation button to reveal the breakpoints
the dictionary knows about. One tilde (~) is the
preferred location, two tildes indicates a less sat-
isfactory alternate breakpoint, and three tildes
indicates InDesign’s last choice.

To customize the breakpoints, insert or
remove tildes as you deem fit, following the
rule of one tilde = preferred, more tildes = okay
to break here if the preferred location doesn't
work. Adding a tilde in front of the first charac-
ter and removing all the other ones from the
word tells InDesign “Don’t hyphenate this word,
ever”

When you're finished customizing the hy-
phenation breakpoints, click the Add button to
save your hyphenation exception to the diction-
ary. When you click the Done button, InDesign
runs through your document and recomposes it
with your exceptions as necessary.—Anne-Marie
Concepcion, from an InDesignSecrets.com blog

entry. Used with permission.
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may mean “short lines” (small bits of text for
the last line of a paragraph). This is an industry
no-no; unless your arm is twisted or there is a
pressing need, turn off this option.

There’s one more place to go for hyphenation fi-
nessing, especially when names aren'’t capitalized
and you don't want hyphenation (“creativepro.
com,” for example). For details, see “Control the
Hyphenation Dictionary.”

It’s Really Simple

Although there’s a lot of theory behind this article,

it boils down to some simple advice:

} Strive for even typographic color, avoiding
big gaps or cramped text in justified type.

} Body copy should usually be hyphenated, yet
it's off by default for placed text. Turn it on.

) Rarely or never hyphenate headlines, sub-
heads, and captions.

} Flush-left type that's set to a wide measure can
go without hyphenation. Furthermore, the
shorter the column width, the tighter the rag.

} The Adobe Paragraph Composer is the best
hyphenation method since it assesses the
needs of the entire paragraph before insert-

MAGAZINEgI‘I

ing hyphens to ensure that the worst spots
are remedied. But when you hand-rag text,
switch to the Single-Line Composer to avoid
changes in the line breaks above the line
you're working.

Frequency: One size does not fit all. Consider
your column or frame width. If it's fairly wide,
such as with a two-column grid, turning on
hyphenation may be all you need for justified
text. For flush-left text, you might even leave
it turned off. But for three-column layouts and
shorter column widths, work with the slider bar
in the Hyphenation dialog. For justified text,
consider increasing hyphenation by narrowing
the Word Spacing range between Minimum
and Maximum values in the Justification dia-
log—and possibly adding small amounts of
Letter Spacing and Glyph Scaling.
Incorporate your H&J settings into your para-
graph styles. Then good hyphenation happens
automatically once you've applied styles.

Follow these H&J suggestions and your read-

ers won't stumble over badly set type. Instead,
they’ll concentrate on the vital messages you're
now successfully communicating.

Eda Warren is president
of Desktop Publishing
Services, Inc., in Chicago,
providing graphic training
and design services. She
is an Adobe Certified
Instructor, ACE-Certified
on InDesign CS2. Warren
has taught graphic
design nationally and
internationally for 15
years. She will soon be
recording an extensive
digital video training on
InDesign CS3 for Studio
eWorks, provider to Mac
and Windows Academy, as
well as their own channels.
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